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Course information

I All information in syllabus on blackboard!
I Tomorrow...

I Lectures every Monday and Thursday
I Thursday will be more practical, but can still be a lecture

I Every week an assignment
I Deadline 15:00 on Thursday!
I Conceptual questions and practical questions

I Final Project (more info on Monday)
I Paper and presentation in groups of 2. Topics may include:

I Analyze your own dataset
I Gather and analyze data
I Review the literature (topics on blackboard)
I Re-analyze an existing dataset



Individual Assignments

Each week, the assignment will be made available 15:00 on
Thursday, and will be due 15:00 the next Thursday. Each
assignment will contribute to 10% or 5% (first and last week) of
your grade.

I Work on the assignments alone.
I Hand in a PDF file and an .R file.
I Make sure your PDF report is as standalone readable as

possible. E.g., if you are asked to report a network, then
include the plot in the PDF and not just say “look at .R file”.

I Assignments are due before 15:00. If you do not hand in an
assignment before 15:00, you will get a 1.

I If you encounter any problems, or have any feedback, please let
me know before the deadline, as then I can take it into account
or help you.





What is R?

I R is a statistical programming language
I Statistical analysis
I Data visualization
I Data mining
I General programming

I It is open-source
I Free as in “free beer”" and “free speech”
I Large active community around R
I Many contributed packages



What do you need to know about R?

I In this course not much. We intend the methods we will
describe to be usable by researchers with little experience in R

I No programming
I Cookbook method

I But it is strongly advised that you learn more about R if you
want to do more in methodology or psychometrics.

I To install R and RStudio see links section on Blackboard



Installing R and RStudio

I R
I This is the base programming language
I Downloadable from http://cran.r-project.org/
I It gives a program called R or RGui which we will never use

I RStudio
I New and very good GUI for R
I Downloadable from

http://www.rstudio.com/products/rstudio/download/

I Always use R from within RStudio!

http://cran.r-project.org/
http://www.rstudio.com/products/rstudio/download/


First use of R

I We will use the environment RStudio for our work in R
I RStudio has 4 panes:

I Console This is the actual R window, you can enter commands
here and execute them by pressing enter

I Source This is where we can edit scripts. It is where you should
always be working. Control-enter sends selected codes to the
console

I Plots/Help This is where plots and help pages will be shown
I Workspace Shows which objects you currently have

I Anything following a # symbol is treated as a comment!



To change the layout of panes in RStudio, fo to Tools -> Global
Options -> Pane Layout. Make sure you set it like this:







The R console



The R console

I The console pane is where R operates
I In the console pane, we can type commands and press enter to

have R evaluate them
I To ask R the answer to 1 + 1, we can type in 1 + 1 and press

enter:

I

I The arrow-up key lets us go back to a previous command
I This is how R works, we write commands for R to evaluate

I Commands can be as simple as 1 + 1 or much longer encoding
an entire data analysis



In the sheets, we use gray boxes to demonstrate commands we send
to R. The values that R returns are shown underneath the gray
boxes followed by the ## symbols.

For example, the command:

will be referred to in the sheets as:

1 + 1

## [1] 2



Comments in R

1 + 1 # Here I sum 1 and 1!

## [1] 2

I The # sign is used because R stops evaluating any command
whenever it sees #

I Everything after # is not an R command.
I # can be used as comments to clarify your code

I Do this as often as you can!



The source pane



The source pane

I Often, you need to evaluate many commands sequentually
I A command to read the data
I Comands to transform the data
I Commands to plot the data
I Commands to analyze the data
I . . .

I You want to be able to save these commands so that you can
later reuse them

I To do this, you need to write an R script
I Plain-text file with the extension .R that contains all your codes

I R scripts are written and edited in the source pane



Create a script using file -> New File -> R script:



Save the script using file -> Save as:

I Save scripts with the extension .R.
I Save your scripts often!

I control+S



Type all your commands into the script:



Select the commands you want to evaluate:



Press the run button or control + enter on your keyboard
(command + enter for Mac users)



Now the command is sent to and evaluated in the R console!

I Never directly use the console! Always work like this!





Assign and use objects

I The <- operator can be used to store values into objects
I An object can be given an arbitrary name
I Alternatively = can be used to do the same thing

I an object can contain anything in R
I R expressions that are not stored in an object are printed



You can assign the number 1 to an object which I call a:

a <- 1



You can assign the number 1 to an object which I call a:

a <- 1

Now whenever I ask R What a is it gives me 1:

a

## [1] 1



You can assign the number 1 to an object which I call a:

a <- 1

Now whenever I ask R What a is it gives me 1:

a

## [1] 1

You can use this object in calculations:

a + 1

## [1] 2



All your objects are listed in the workspace pane:



Objects can have any name you want:

anyNameYouWant <- 10
anyNameYouWant

## [1] 10

I Case sensitive! object, Object and OBJECT are different
objects!

I It is recommended to use informative object names
I sampleSize
I rawData
I nMales

I Use camel case
I Start object name with lowercase letters, start new objects with

lowercase and capitalize every word



Working Directory

The working directory is the folder on your computer in which R
works:

getwd()
setwd("~/Documents")
getwd()



I recommend to never use setwd() or getwd() but to use the
RStudio menu:

Write R codes assuming this is done (R script in same folder as data
and/or output).



Vectors

I A vector is an object that stores multiple values of the same
mode

I Use c(...) to manually create a vector
I For example, c(1,2,3) creates the vector

[
1 2 3

]
I A colon can be used to create an integer sequence



Vectors

Create a vector using c(...):

numericVector <- c(1, 5, 10)
numericVector

## [1] 1 5 10



Functions

I A function is a small program, it takes input, does something
and gives you output

I It is always of the form name(argument, argument,
argument, ...)

I A documentation can be found for every function using ?name
I The documentation tells you what you need to put into a

function and what comes out of it

I You need to know the exact name of the function you want to
use

I Reference card
I Use Google!

http://cran.r-project.org/doc/contrib/Short-refcard.pdf
http://en.lmgtfy.com/?q=correlation+in+R


Functions

a <- c(5, 2, 10, 1)
# Compute mean of v1:
mean(a)

## [1] 4.5

# Compute sum of v1:
sum(a)

## [1] 18

# Help pages of these functions:
?mean
?sum



Help pages appear in the plots/help pane:



Object Modes

I There are different types of objects in R:
I numeric
I character
I logical

I There are called modes



The numeric mode stores numbers:

numericObject <- 115
numericObject + 1

## [1] 116



Strings

Anything between single or double quotation marks is stored as a
character, which can be used to encode strings:

characterObject <- 'this is a string'
characterObject

## [1] "this is a string"

characterObject2 <- '1'
characterObject2 + 1

## Error in characterObject2 + 1: non-numeric argument to binary operator



Logicals

The logical mode indicates a boolean object which can only be
true (TRUE) or false (FALSE):

logicalObject <- TRUE
logicalObject

## [1] TRUE

I Shortcuts for TRUE and FALSE are T and F
I Avoid using these shortcuts!



Packages

I Packages are extensions contributed to R containing extra
functions

I Stored on the Comprehensive R Archive Network (CRAN)
I Over 8000 contributed packages! All containing functions

I Packages can be installed using install.packages()
I Needs to be done only once

I Afterwards they can be loaded using library()
I More information on packages on the CRAN site for that

package:
I cran.r-project.org/package=PACKAGENAME
I Or search for CRAN PACKAGENAME



Packages

# Install package "qgraph"
install.packages("qgraph")

# Load package "qgraph":
library("qgraph")



Matrices

I A very important function for this course is matrix(). It
creates a matrix, which is basically a two dimensional table.

I Technically, a matrix is a vector with two dimension attributes
I Rows indicate horizontal lines of cells
I Columns indicate vertical lines of cells
I The first argument of matrix is a vector to fill the matrix with,

the second argument the number of rows and the third
argument the number of columns (see also ?matrix)

I Again they can be indexed with square brackets, but now need
both row and column information, separated by a comma



Matrices

# A matrix:
m <- matrix(1:9, nrow=3, ncol=3)
m

## [,1] [,2] [,3]
## [1,] 1 4 7
## [2,] 2 5 8
## [3,] 3 6 9



Indexing matrices

# Index first row second column:
m[1,2]

## [1] 4

# Overwrite an element:
m[3,3] <- 0
m

## [,1] [,2] [,3]
## [1,] 1 4 7
## [2,] 2 5 8
## [3,] 3 6 0



Indexing matrices

# First row and all columns:
m[1,]

## [1] 1 4 7

# First 2x2 block:
m[1:2,1:2]

## [,1] [,2]
## [1,] 1 4
## [2,] 2 5



# Number of rows:
nrow(m)

## [1] 3

# Number of columns:
ncol(m)

## [1] 3



Lists
# A vector:
v1 <- c(5,10,1,3)
v1

## [1] 5 10 1 3

# A matrix:
m1 <- matrix(c(5, 2, 10, 1),2,2)
m1

## [,1] [,2]
## [1,] 5 10
## [2,] 2 1

# Put them in a list:
l1 <- list(v1 = v1, m1 = m1)



Lists

str(l1)

## List of 2
## $ v1: num [1:4] 5 10 1 3
## $ m1: num [1:2, 1:2] 5 2 10 1



Indexing lists
# Index the vector v1:
l1$v1

## [1] 5 10 1 3

l1[['v1']]

## [1] 5 10 1 3

# Change an element in the matrix m1:
l1$m1[2,2] <- 0
l1$m1

## [,1] [,2]
## [1,] 5 10
## [2,] 2 0



Data frames

I The data.frame() function can be used to create a data
frames

I A data frame is a combination of a matrix and a list
I Looks like a matrix and can be indexed as one
I Contains variables as each row, which can be indexed as in lists

I This is the structure you will use when working with data
I Very similar to how data is stored in SPSS!



Data frames

# A character vector:
sex <- c("male","female","male","female")

# A logical vector:
exp <- c(TRUE,TRUE,FALSE,FALSE)

# 2 numeric vectors:
A <- c(5,10,1,3)
B <- 1:4

# Put them in a data frame:
df1 <- data.frame(sex=sex,exp=exp,A=A,B=B)



Data frames

df1

## sex exp A B
## 1 male TRUE 5 1
## 2 female TRUE 10 2
## 3 male FALSE 1 3
## 4 female FALSE 3 4



Indexing data frames
# Index the vector sex:
df1$sex

## [1] male female male female
## Levels: female male

df1[['sex']]

## [1] male female male female
## Levels: female male

# Subset of the data containing only A and B:
df1[,c('A','B')]

## A B
## 1 5 1
## 2 10 2
## 3 1 3
## 4 3 4



Importing data
Is now very easy!



Correlation matrix
Some functions take a data frame as input. Very important in this
course is the function cor, which takes a data frame as input and
computes the correlation matrix. The function cov computes the
covariance (unstandardized correlations).

# Covariance matrix:
cov(df1[,c('A','B')])

## A B
## A 14.91667 -2.500000
## B -2.50000 1.666667

# Correlation matrix:
cor(df1[,c('A','B')])

## A B
## A 1.0000000 -0.5013947
## B -0.5013947 1.0000000



Missing data

Missing data is encoded in R with NA

a <- NA
NA

## [1] NA

Missing data needs to be handled often using arguments in functions



Missing data

Check the help files! ?cor

a <- c(1,2,NA,4)
b <- c(1,3,2,8)
cor(a,b)

## [1] NA

cor(a,b,use = "pairwise.complete.obs")

## [1] 0.9986254



Missing data

Or use na.omit

Data <- cbind(a,b)
cor(na.omit(Data),use = "pairwise.complete.obs")

## a b
## a 1.0000000 0.9986254
## b 0.9986254 1.0000000



Please work through the (very) short introduction to R (on
blackboard and available at https://cran.r-project.org/doc/
contrib/Torfs+Brauer-Short-R-Intro.pdf) before starting
this assignment. You can skip section 11 on programming.

https://cran.r-project.org/doc/contrib/Torfs+Brauer-Short-R-Intro.pdf
https://cran.r-project.org/doc/contrib/Torfs+Brauer-Short-R-Intro.pdf

